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Introduction SOLIDWORKS 2020 - 2021

To the Teacher The SOLIDWORKS Education Edition - Fundamentals of 3D Design
and Simulation manual is designed to assist you in teaching
SOLIDWORKS and SOLIDWORKS Simulation in an academic
setting. This guide offers a competency-based approach to teaching 3D
design concepts, analysis and techniques.

Qualified schools on subscription have access to the eBook at no ¢
to students. Contact your SOLIDWORKS Value Added Reselles
obtain access.

SOLIDWORKS The SOLIDWORKS Education Edition
Tutorials - Fundamentals of 3D Design and

Simulation manual also supplements
the SOLIDWORKS Tutorials.

= Assemblies Lessan 3 Drawisgs.

Accessing the To sta %WORKS Tutorials, click Help, SOLIDWORKS

SOLIDWORKS Tutorials:’{The SOLIDWORKS window is resized and a second
Tutorials w appears next to it with a list of the available tutorials. There are
ssons in the SOLIDWORKS Tutorials. As you move the

inter over the links, an illustration of the tutorial will appear at the
ttom of the window. Click the desired link to start that tutorial.

TIP: When you use SOLIDWORKS Simulation to perform analysis,

click Help, SOLIDWORKS Simulation, Tutorials to access
over 50 lessons and over 80 verification problems. Click
Tools, Add-ins to activate SOLIDWORKS Simulation,
SOLIDWORKS Motion, and SOLIDWORKS Flow
Simulation.
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Conventions

Printing the
SOLIDWORKS
Tutorials

Introduction

Set your screen resolution to 1280x1024 for optimal viewing of the
tutorials.

The following icons appear in the tutorials:

next 2IMoves to the next screen in the tutorial.

¢ Represents a note or tip. It is not a link; the information is below
the icon. Notes and tips provide time-saving steps and helpful Hints.

i You can click most buttons that appear in the lessonstto flash the
corresponding SOLIDWORKS button.

@ Open File or Set this option automatically@pens theifile or sets
the option.

@_ Acloser look at... links to more informatign about a topic.
Although not required to complete the tutorial, it offers more detail on
the subject.

@ Why did I... links to more’information about a procedure, and

the reasons for the method given. This information is not required to
complete the tutorial.

(& ) Show me..jdemonstrates with a video.

If you like, you camprifit the SOLIDWORKS Tutorials by following
this procedures

1. On thestutotial navigation toolbar, click Show.

This\displays the table of contents for the SOLIDWORKS
Tutorials.

2. ARight-click the book representing the lesson you wish to print and
select Print... from the shortcut menu.

The Print Topics dialog box appears.

3. Select Print the selected heading and all subtopics, and click
OK.
4. Repeat this process for each lesson that you want to print.
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My SOLIDWORKS

Certification
Exams

Training Files

Educator
Resources link
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My.SolidWorks.com is a community website to share, connect, and
learn everything about SOLIDWORKS. My SOLIDWORKS learning
contains additional video lessons and individual learning paths for your
students.

The Certified SOLIDWORKS Associate(CSWA) - Academic program
provides free certification exams for you or your students in a
proctored setting. Achieving CSWA proves the fundamentals of.
engineering design competency. Employers verify students job ready
credentials through our online virtual tester. Schools that pfevide two
or more courses in SOLIDWORKS-based instruction caf alsovapply to
be a Certified SOLIDWORKS Professional(CSWP) fAcademic
Provider.

More information and to apply can be found at
www.solidworks.com/cswa-academic.

A complete set of the various files usedsthgotughotit the course can be
downloaded from the following website:
www.solidworks.com/EDU_Eundamentals3DDesignSim

The files are organized by lesson number. The Case Study folder
within each lesson contain$ the files#you need when presenting the
lessons. The Exercises‘foldermeentains any files that are required for
doing the laboratoryfexercises.

The Instructors’Cutriculum link on the SOLIDWORKS Resources

4 tab of theflask’Pane’includes substantial supporting materials to aid
in your cougse presefitation. Accessing this page requires a login
account forghe SOLIDWORKS Customer Portal. These supporting
materialstafford you flexibility in scope, depth, and presentation.

I. Start SOLIDWORKS.
Using the Start menu, start the SOLIDWORKS application.
2. SOLIDWORKS Content. . SolidWorks Resources &

Click SOLIDWORKS Resources |4} to —

|| New Document
open the SOLIDWORKS Resources Task (=¥ Open a Document
Pane. il Student Curriculum

3 Instructors Curriculum
Click on the Instructors Curriculum link S Ttorisis
which will take you to the Foumatsen

1/ General Information

SOLIDWORKS Customer Portal web
page.
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Prerequisites

Course Design
Philosophy

A Note About
Dimensions

Conventions Used
in this Book

Windows

Introduction

Students attending this course are expected to have the following:

m Mechanical design experience.

m Experience with the Windows® operating system.

m Completed the online tutorials that are integrated in the
SOLIDWORKS software. You can access the online tutorials by
clicking Help, Online Tutorial.

This course is designed around a process- or task-based approdch to
training. A process-based training course emphasizes the precesses and
procedures you follow to complete a particular task. By itilizing €ase
studies to illustrate these processes, you learn the nece$§saty commands,
options and menus in the context of completing a gask.

The drawings and dimensions given in the lab gxetcises are not intended
to reflect any particular drafting standard. In factj)sometimes dimensions
are given in a fashion that would never be considered acceptable in
industry. The reason for this is the labgsare'designéd to encourage you to
apply the information covered in classyand to'employ and reinforce
certain techniques in modeling. AS atesult the drawings and dimensions
in the exercises are done in a way that ¢omplements this objective.

This manual uses the following typographic conventions:

Convention Meaning

Bold Sans Serif SOLIDWORKS commands and options

appear in this style. For example, Features >

Extruded Cut [@ means click the Extruded
Cut icon on the Features tab of the
CommandManager.

Typewriter Feature names and file names appear in this

style. For example, Sketchl.

Double lines precede and follow sections of
the procedures. This provides separation
between the steps of the procedure and large
blocks of explanatory text. The steps
themselves are numbered in sans serif bold.

17 Do this step

The screen shots in this manual were made using the SOLIDWORKS

software running a mixture of Windows® 7 and Windows 10. You may
notice slight differences in the appearance of the menus and windows.
These differences do not affect the performance of the software.
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Use of Color The SOLIDWORKS user interface makes extensive use of color to
highlight selected geometry and to provide you with visual feedback.
This greatly increases the intuitiveness and ease of use of the
SOLIDWORKS software. To take maximum advantage of this, the
training manuals are printed in full color.

Also, in many cases, we have used Racius S0mm
additional color in the illustrations to
communicate concepts, identify
features, and otherwise convey
important information. For example,
we might show the result of a filleting
operation with the fillets in a different ~ adus smm
color even though, by default, the

Raodius smim, 4 Places

Graphics and The SOLIDWORKS software sets a new
Graphics Cards standard with best-in-class graphics.

Graphics is an effective tool f
evaluating the quality of
models and surfaces.

RealView Graphi ardware
(graphics card of advanced
shading in r example, if you
rotate a its rendered appearance throughout the rotation.

¢ SOLIDWORKS software provides several
olor schemes that control, among other things, the colors

Color Schemes Out o

¢'have not used the same color scheme for every case study and
ercise because some colors are more visible and clear than others
when used with different colored parts.

In addition, we have changed the viewport background to plain white
so that the illustrations reproduce better on white paper.

As a result, because the color settings on your computer may be
different than the ones used by the authors of this book, the images you
see on your screen may not exactly match those in the book.

r Interface Throughout the development of the software, there have been some
Appearance cosmetic User Interface changes, intended to improve visibility, that do
not affect the function of the software. As a policy, dialog images in the
manuals which exhibit no functional change from the previous version
are not replaced. As such, you may see a mixture of current and “old”
UI dialogs and color schemes.
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Upon succesgful Ztion of this lesson, you will be able to:

th characteristics of a feature-based, parametric solid
ish between sketched and applied features.
ify the principal components of the SOLIDWORKS user

interface.
Explain how different dimensioning methodologies convey

different design intents.
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SOLIDWORKS Basics and the User Interface

What is the
SOLIDWORKS
Software?

SOLIDWORKS mechanical design automation software is a feature-
based, parametric solid modeling design tool which takes advantage of
the easy to learn Windows graphical user interface. You can create fully
associative 3D solid models with or without constraints while utilizing
automatic or user defined relations to capture design intent.

The italicized terms in the previous paragraph mean:

Feature-based

Just as an assembly is made up of a number of individual piec@ parts, a
SOLIDWORKS model is also made up of individual constitaent
elements. These elements are called features.

When you create a model using the SOLIDWORKSSoftware, you
work with intelligent, easy to understand geometric feafures such as
bosses, cuts, holes, ribs, fillets, chamfers, and draftsspAsfthe features are
created they are applied directly to the wotk pieces

Features can be classified as either sk€tched or*applied.

m Sketched Features: Based upemsa 2B sketch. Generally that sketch
is transformed into a solid by extrusion, rotation, sweeping or
lofting.

m Applied Features: Createdsdisectly on the solid model. Fillets and
chamfers are examples ef this type of feature.

The SOLIDWORKSysoftware graphically shows you the feature-based
structure of your mtodehin a special window called the
FeatureManagef® deSign tree. The FeatureManager design tree not only
shows you the sequence in which the features were created, it gives you
easy access to all the underlying associated information. You will learn
mote about'the FeatureManager design tree throughout this course.

Tosllustrate the concept of feature-
based modeling, consider the part O
shown at the right:

This part can be visualized as a
collection of several different
features — some of which add
material, like the cylindrical boss,

and some which remove material,
like the blind hole.
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If we were to map the individual features to their corresponding listing
in the FeatureManager design tree, it would look like this:

(% Bracket.SLDPRT EEE ECEE=N(EcE =
— PALAZE- O -+ @@ -1

¢ BER( O[S

N4

% Bracket (Default<<Default>_Display State
History
Sensors
4 Annotations
§E Material <not specified>
|i| Front

i Top

of
[-
[ Right
I_, Origin

L4 éﬂ Base-Extrude

4 éﬂ Boss-Extrudel s

4 éﬂ Boss-Extrude?

([ Holel Z

< 1 | v| FIlsometric

[WIRTFT8] Model [ 3D Views | Motion Studyl |

m Parametric
The dimensions and relatig reate a feature are captured and
stored in the model. Thi enables you to capture your design
intent, it also enable 0 quickly and easily make changes to the
model.

m Driving

elations: These include such information as parallelism, tangency,
and concentricity. Historically, this type of information has been
communicated on drawings via feature control symbols. By
capturing this in the sketch, SOLIDWORKS enables you to fully
capture your design intent up front, in the model.

m Solid Modeling
A solid model is the most complete type of geometric model used in
CAD systems. It contains all the wire frame and surface geometry
necessary to fully describe the edges and faces of the model. In addition
to the geometric information, it has the information called topology that
relates the geometry together. An example of topology would be which
faces (surfaces) meet at which edge (curve). This intelligence makes
operations such a filleting as easy as selecting an edge and specifying a
radius.



Lesson 1

SOLIDWORKS 2020 - 2021

SOLIDWORKS Basics and the User Interface

Design Intent

10

Fully Associative

A SOLIDWORKS model is fully associative to the drawings and
assemblies that reference it. Changes to the model are automatically
reflected in the associated drawings and assemblies. Likewise, you can
make changes in the context of the drawing or assembly and know that
those changes will be reflected back in the model.

Constraints

Geometric relationships such as parallel, perpendicular, horizontal,
vertical, concentric, and coincident are just some of the constraints
supported in SOLIDWORKS. In addition, equations can‘be used to
establish mathematical relationships among parametefs. By using
constraints and equations, you can guarantee that d€sign coneepts such
as through holes or equal radii are captured and maintaified.

Design Intent
The final italicized term is design intent. This subject is worthy of its
own section, as follows.

In order to use a parametric modeler, [tke SOLIDWORKS efficiently,
you must consider the design ifitent beéfore modeling. Design intent is
your plan as to how the model should’behave when it is changed. The
way in which the modelds created governs how it will be changed.
Several factors contributed how you capture design intent:

Automatic (sketch) Relations

Based on howggeometsy is sketched, these relations can provide
common geometfic relationships between objects such as parallel,
perpendi€ular, hetiZzontal, and vertical.

Equations
Used to relate dimensions algebraically, they provide an external way
to force changes.

Added Relations

Added to the model as it is created, relations provide another way to
connect related geometry. Some common relations are concentric,
tangent, coincident, and collinear.

Dimensioning

Consider your design intent when applying dimensions to a sketch.
What are the dimensions that should drive the design? What values are
known? Which are important for the production of the model? The way
dimensions are applied to the model will determine how the geometry
will change if modifications are made.

Consider the design intent in the following examples.
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Examples of The design intent of each sketch below is slightly different. How will
Design Intent the geometry be affected if the overall plate width, 100mm, is
changed?
A sketch dimensioned like this will keep 100
the holes 20mm from each end regardless
of the width of the plate.

1o

Baseline dimensions like this will keep the 1
holes positioned relative to the left edge of
the plate. The positions of the holes are not

affected by changes in the overall width - Q
the plate.

Dimensioning from the e
center to center will ma
between the hole ce and allow it to be
changed that way.

How Features
Affect Design
Intent 4

e of a simple stepped shaft as shown at
e right. There are several ways a part like
this could be built and each way creates a
part that is geometrically identical.

The “ r Cake” The layer cake approach builds the part one piece at a time, adding each
A ach layer, or feature, onto the previous one, like this:

Changing the thickness of one layer has a ripple effect, changing the

position of all the other layers that were created after it.

1"
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The “Potter’s
Wheel” Approach

The Manufacturing
Approach

File References

12

The potter’s wheel approach builds the part as
a single, revolved feature. A single sketch
representing the cross section includes all the
information and dimensions necessary to make
the part as one feature. While this approach
may seem very efficient, having all the design
information contained within a single feature

4
limits flexibility and can make changes awkward.
The manufacturing approach to modeling mimics the way the
would be manufactured. For example, if this stepped& turned
\4

s
on a lathe, you would start with a piece of bar stock afid femo
material using a series of cuts.

swer when trying to determine

which approach to use. S allows for great flexibility and
making changes to me s relatively easy. But creating models with
design intent in mi
modifiable andg nited for re-use, making your job easier.

enced files do not have to be stored with the document that
aces them. In most practical applications, the referenced

OLIDWORKS provides several tools to determine the references that
ist and their location.
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Object Linkingand  In the Windows environment, information sharing between files can be
Embedding (OLE) handled either by linking or embedding the information.

The main differences between linked objects and embedded objects are
where the data is stored and how you update the data after you place it
in the destination file.

Linked Objects When an object is linked, information is updated only if the source
is modified. Linked data is stored in the source file. The destina e
stores only the location of the source file (an external referenc
displays a representation of the linked data.

Linking is also useful when you want to include mfo
maintained independently, such as data collected
department.

Embedded Objects When you embed an object, information in the on file doesn't
change if you modify the source file. Embedded objects become part of

the destination file and, once inserte er part of the source

file.
File Reference The many different types of exte eferences created by
Example SOLIDWORKS are show & ing graphic. Some of the

Library Feature Insert Part
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Opening Files

Computer Memory

Random Access
Memory

SOLIDWORKS is a RAM-resident CAD system. Whenever a file is
opened, it is copied from its storage location to the computer’s Random
Access Memory or RAM. All changes to the file are made to the copy
in RAM and only written back to the original files during a Save
operation.

Open

es are stored and which copy of the file
we are workin important to differentiate between the two main

emory only stores information when the computer is
hen the computer is turned off, any information in RAM is

ed memory is all the non-volatile memory. This includes computer
drives, flash drives and CD/DVD drives. Fixed memory holds its

Fixed Memory
Ofomation even when the computer is not running.

14
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The SOLIDWORKS user interface is a native Windows interface, and

SOLIDWORKS as such behaves in the same manner as other Windows applications.
User Interface Some of the more important aspects of the interface are identified

below.

2 SOLI‘DW’ORKS‘ F{e Edit View Insert Tools Window Help ;f| A0 B-5- 8 7
CN |/ 0 RO T 0OV-0- HAhA @ Le

Feature}| Sketch | Evaluate | Diripert | SOLIDWORKS Add-Ins | SOLIDWO%
\—Menu Bar Y= Menu Bar pull-downs CommandMana

% Bracket SLOPRT
= POELBEE - D & T
" e A
% T
g FeatureManager
Bracket (Default<<Default=_Di . He
. design tree

Vie

Sensors
4 Annetaticns
855 Material <not sefécified>
[ Front ]
1 Top )

[ Right
L, origin

» ] Base-Extrude
» ] Boss-Extrudel

LessonD7 b

® & &

ADDDRAFT  Bracket  Design Intent:
1

@ @

» ) Boss-Extrude2 )

Design Intent Design Intent
,

(¥ Holet p 5
Grap v
< >| *lsemetric T
T Mogdel | 3D Views | Motion Study 1 |
Status Bar
Document Window
SOLIDWORKS Prermium 2018 x64 Edition Editing Part Custorn = [

0

Welcome Dialog The Welcomegdialogbox opens with SOLIDWORKS to provide

Box

Note

convenient C

ate new documents, open existing documents,
RKS resources and news.

Welcome - SO ORKS Premium 2020 7?7 X

@ Assembly Drawing @ Open

Recent Documents View all

Recent

Universal Joint_SLD... ® | |FlashlightSLDASM ~ # | Design IntentSLDPRT Design Intent 35LD... Design Intent 25LD...
5 el el el
@ @ Sy Sy Sy
< >
Recent Folders View all Resources
F— Lesson01 ~
- C\Users\FKR\Desktop\Essentials 2020\Build Essentials\Lesso. @& What's New B Beta Home

— Case Study
L] CA\Users\FKR\Desktop\Essentials 2020\Build Essentials\Lesso,

MySolidWorks Beta Hot Issues
F— english
L cprogram FiesisoLDwORKS CorpisOLDWORKS (Ziang
% Beta Forum @ Report a Beta Issue
M Large Assem|
DA SALINVOR la<\ Assamhh: AMadalinal L essand. v
@ Arrow keys rotate the model. Ctrl + Arrow Keys pan the model. Alt + Arrow Keys rotate the model clockwise and counterclockwise. < >

[ bo nat show on startup

This dialog box can also be set to Do not show on startup.
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Pull-down Menus The Pull-down menus provide access to many of the commands that
the SOLIDWORKS software offers. Float over the right facing arrow
to access the menus. Click the pushpin to keep the menus open.

‘D%SOLIDWORKS"‘ D '@'ﬁ'%' - l} 2 0 0% - Part2 #®; Search Community Forum Qv ?2-_E0O X

‘D%SOLFDWORKS‘ File Edit View Insert Tools Window Help "I D '@' ﬁ - % - - h = a e ? - o O X

When a menu item has a right-pointing @ Wirchrame
arrow like this: | Display ) |’ it (] Hidden Lines Visibl

. . ~] Hidden Li R
means that there is a sub-menu associated S;a d: “:es e:e
with that choice. ) Shaded

When a menu item is followed by ellipses

hke thlS |Q9 Orientation... SpaceBar |’ lt means
that the option opens a dialog box with
additional choices or information.

Curvature
;\‘, Zebra Stripes

Customizing When the Customize Menuit ected, each G2 Redraw  CulsR
Pull-down Menus item appears with a ch Clearing the check Screen Capture >
box removes the ass item from the menu. Display >
Modify »
Lights and Cameras »
Hide / Show 3
Toolbars 3
Workspace »
User Interface »
3:: Full Screen Fl11
Using the ommandManager is a set of icons divided into tabs that are
Command owards specific tasks. For example, the part version has several
Manager to access commands related to features, sketches, and so on.
V- ©
-e-@-A Convert - Raz;d Insta@ntzn

Sketch

@ Swept Boss/Base @ @ [[—é Swept Cut E? EE @ Rib @ Wrap "iii U

ol Fillet Linear - Reference Curves
EBxtruded  Revolved ‘ Lofted Boss/Base Extruded Wizard Revolved @ Lofted Cut Pattern E Draft [ﬁ Intersect Geometry
Boss/Base Boss/Base ut Cu

@ Boundary Boss/Base - @ Boundary Cut - - Qﬁ] Shell H{l Mirror - -

Features | Sketch | Evaluate | DimXpert | SOLIDWORKS Add-Ins | SOLIDWORKS MED |

Note The CommandManager can be displayed with or without text on the
buttons. These images show the Use Large Buttons with Text option.

16
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Adding and
Removing
CommandManager
Tabs

FeatureManager
Design Tree

Lesson 1
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The default settings display multiple CommandManager tabs for a part
file. Others can be added or removed by right-clicking on any tab,
clicking Tabs, and clicking or clearing the tab by name.

Enable CommandManager
Use Large Buttons with Text
Tabs r Assembly
Toolbars 4 Layout
Customize... Sketch
Sketch Ink
Markup
Evaluate
Render Tools
SOLIDWORKS Add-Ins
MED

The FeatureManager design
tree is a unique part of the
SOLIDWORKS software
that visually displays all the
features in a part or
assembly. As features
created they are ad

DimXpertManager
DisplayManager

% ADD DRAFT (Default<<Default>_Display

~ Hide/

History Show

Sensors D|Sp|ay
» [&] Annotations Pane

85 PW20:29:5c:0:
:

[
g

[ Top Hide/
[ Right 1 Show
L Origin i FM
L4 @ Base-Extrude
[P Fillett
[P Filler2
() Shellt
» @] Rib
L4 @ CylBoss
[P Fillets
[P Fillets

L4 @ CounterSnk

| Front

reManager design tree
s access to the
ing of the features
bjects) that it contains.
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Show and Hide
FeatureManager
Items

Tip

18
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Many FeatureManager items (icons and folders) are hidden by default.
In the image above, only the History, Sensors and Annotations

folders are shown.

Click Tools, Options, System Options, and FeatureManager to
control their visibility using one of the three settings explained below.

Hide/show tree items
Blocks

@ Design Binder
Annotations

[@) sotid Bodies

@ Surface Bodies
Tables

@ Favarites

4}@ eDrawing Markups

Selection Sets

Markups

Automatic

Automatic

Show

Automatic

Automatic

Automatic

Automatic

Automatic

Automatic

Automatic

kil Equations

y—

~ 2% Material

il i Default Planes
s L arigin

it Mate References
kil @ Design Table

it Sensars

~ History

@ Graphig

m Hide -
m Show-

The CommandMa
dockedon t
a differen

Hide the ite
Show the i

Automatic

Show ~

Show ~

Show

At ~
amatic

ho

Sh ~

omatic v

or PropertyManager can be dragged and
r outside of the SOLIDWORKS window or to
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PropertyManager

Full Path Name

Selection
Breadcrum

Note

Lesson 1
SOLIDWORKS Basics and the User Interface

Many SOLIDWORKS commands are executed through the
PropertyManager. The PropertyManager occupies the same screen
position as the FeatureManager design tree and replaces it when it is in

use.

The top row buttons contain the
standard OK and Cancel buttons.

Below the top row of buttons are
one or more Group Boxes that
contain related options. They can
be opened (expanded) or closed
(collapsed) and in many cases
made active or inactive.

OK
Can

n Fi

Open and
Close icon

Group Box

Open a%

Q
e

election Breadcrumbs show the
hierarchy of objects based on a selected
piece of geometry. For example, selecting
a face can lead to a series of objects
including the feature, sold body, component, subassembly, and finally
to the top level assembly.

Group Box=———»
Closed and inactive

+ ltems

SR

Fillet

&

Show selection toolbar
Tangent propagation
() Full preview

() Partial preview

@ Mo preview

Fillet Parameters

(R, [5.00mm )

[ Multi Radius Fillet

Profile:

~

Setback Parameters hd
ADD DRAFT *
ADD DRAFT*

CASOLIDWORKS Training
Files\Essentials\Lesson01\Case
Study\ADD DRAFT.sldprt

P ONH
@ @ % a ﬁDBase-ExtrudeE

L & sketeh

1]

It also leads to the sketch of the feature and the mates attached to that

component.

These visual objects can also be used for access. Right-clicking on the
boss feature offers several editing tools including Edit Feature and

Hide.

These objects and tools will be discussed in later lessons.
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Task Pane

20
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EINIEE

5me
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The Task Pane window contains SOLIDWORKS Resources |f/,

Design Library [@ |, File Explorer [, View Palette [g5,
Appearances, Scenes, and Decals |@|, Custom Properties [E/, and

the SOLIDWORKS Forum options. The window appears on the
right by default but it can be moved and resized. It can be opened/
closed, tacked or moved from its default position on the right side
the interface.

£ Welcome to SOLIDWORKS

SOLIDWORKS Tools

% Property Tab Builder
SOLIDWORKS Rx
Performance Benchmark Test
Compare My Score

% Copy Settings Wizard

% My Products

A
¥

EINIEE)

Online Resources

0 3DEXPERIENCE Marketplace

57 Partner Solutions

Subscription Services

% Subscription Services

5me

CRERE N R=2- 2

> B SOLIDWORKS Content
> @ Design Library
hd @ SOLIDWORKS Essentials
v [ Lesson01
[ Case Study
> [ Lesson02
> 7 Lesson03
> 7 Lesson04
> [ Lesson05
> 7 Lesson06
> [ LessonO

de iterns from hidden features
iew Annotations

Auto-start projected view

Drag views onto drawing sheet.

@
ADD DRAFT - Bracket Design
Intent 1
& @
Design Design
Intent 2 Intent 3

Il = | IL = ]
*Front *Right
*Top *Back
——
*Left *Bottom
*sometric *Dimetric

& &

WTrimmatei- W rrant
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Opening Labs with
the File Explorer

Heads-up View
Toolbar

Unselectab ns

Lesson 1

SOLIDWORKS Basics and the User Interface

You can open parts and assemblies
required for lab exercises using the File
Explorer.

m  Open the Task Pane.

m Click File Explorer [5..

m Expand the Essentials folder used
for the class files. It should be found
under the SOLIDWORKS Training
Files folder.

m Expand the lesson folder
(LessonO1 for example) followed
by either the Case Study or
Exercises folder.

m Double-click a part or assembly file
to open it.

The Heads-up View toolbar is a
transparent toolbar that contai
many common view
manipulation commands,

of the icons (such as th

Show Items icon s )

Flyout Tool butto contain
other options outs
contain a ownfarrow ¥
to acce ommands

« File Explorer x
4 | SOLIDWORKS Training Files a

g [ | Assembly Modeling

i 4 || Essentials

@ 4 | Lesson0l1

B 4 | Case Study

(& ADD DRAFT.sldprt

2 @& Bracket.SLDPRT

% Design Intent 1.

]

>\ Lesson09

| Lessonl0

vz @-o-o[Joa =-

o

iraV

]
DI
%
=]

s O EBRE » -~ =
@ = 2= 2 -

FE#E

At times you will notice commands, icons, and menu options that are
grayed out and unselectable. This is because you may not be working in
the proper environment to access those options. For example, if you are
working in a sketch (Edit Sketch mode), you have full access to all the
sketch tools. However, you cannot select the icons such as fillet or
chamfer on the Features tab of the CommandManager. This design
helps the inexperienced user by limiting the choices to only those that

are appropriate.
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To Preselect or Not?

Mouse Buttons

Shortcut Menu

Note

Keyboard
Shortcuts

22

As arule, the SOLIDWORKS software does not require you to
preselect objects before opening a menu or dialog box. For example, if
you want to add some fillets to the edges of your model, you have
complete freedom — you can select the edges first and then click the
Fillet tool or you can click the Fillet tool and then select the edges. The
choice is yours.

The left, right and middle mouse buttons have distinct meanings in
SOLIDWORKS.

Left
Select objects such as geometry, menus buttons, apd*ebjectsiin the
FeatureManager design tree.

Right
Activates a context sensitive shortcut menuy, The contents of the menu

differ depending on what object the cutsomis owet. These menus also
represent shortcuts to frequently usedycommands.

At the top of the Shortcut. Menu is the BEI°q D R
Context Toolbar. It contains some of the most - .
N . FRPLPLI2O

commonly used commands 11 icorform. L

.. . Select Tangenc
Below it is the pull-dewn fenu. It contains Selec;mfw: ,
other commands that are avatlable in the T T .
context of the s€lection, in this example a face. Recent Commands »

Face

& Change Transparency

The Conteéxt toolbar will also become available as you make selections
with, the leftmouse button. It provides quick access to common
copmands.

Middle
Dynamically rotates, pans or zooms a part or assembly. Pans a drawing.

Some menu items indicate a keyboard shortcut like this:

| g Redraw Ctrl+R |

SOLIDWORKS conforms to standard Windows conventions for such
shortcuts as Ctrl+O for File, Open; Ctrl+S for File, Save; Ctrl+Z for
Edit, Undo and so on. In addition, you can customize SOLIDWORKS
by creating your own shortcuts.
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Multiple Monitor
Displays

Spanning Monitors

Fitting to a Monitor

System Feedback

O&

Lesson 1
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SOLIDWORKS can take advantage of multiple monitor displays to
span monitors and to move document windows or menus to a different
monitor.

Click Span Displays = on the top bar of the SOLIDWORKS window
to stretch the display across both monitors.

ight = on the top bar

A

k4
e

rovided by a symbol attached to the
ow indicating what you are selecting or
t the system is expecting you to select. As the
rsor floats across the model, feedback will come in H
e form of symbols, riding next to the cursor. The
illustration at the right shows some of the symbols: bi Face
vertex, edge, face and dimension.

% o Vertex

Edge

be\ Dimension
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Options

Tip

24
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Located on the Tools menu, the Options dialog box enables you to
customize the SOLIDWORKS software to reflect such things as your
company’s drafting standards as well as your individual preferences
and work environment.

Use the search bar in the upper right of the Options dialog box to find
system options and document properties. Type the label of the chec
box, radio button, or other option to locate the page where the

resides.

System Options - General X
System Options Document Properties & searcy : Q
General Recent documents ~
MED Maximurm recent documents displayed: |50 =
Dirawings [include documents opened from other documents

Display Style

Cpen last used document(s) at startup: Mever L
colors Input dimension value
Sketch [ Isingle command per pick
Relations/Snaps Use shaded face highlighting
Display Show thurnbnail graphics in Windows Explorer
Selection Use system separator for dimensions
Performance Use Englich |
R se English language menus
Assemblies g gusg
External References Use English language feature anddite n
Default Templates
File Locations
FeatureManager
Spin Box Increments
View
Backup/Recover
Touch
Raouting
" Routing File Locations
Hole Wizard,/Toolbox
File Explorer
Search
Collaboration [Ashow latest Technical Alerts and Mews in Welcome dialog
Messages/Errors/Warl i for solutions when SOLIDWORKS crashes
Import [#] Enable sounds for SOLIDWORKS events
Export
Enable VSTA VERSION 3.0
Configure Sounds...
[“] allow cosmetic threads for unarade. v
oK Cancel Help
|
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Customization

Search

Lesson 1
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You have several levels of customization. They are:

System options

The options grouped under the heading System Options are saved on
your system and affect every document you open in your
SOLIDWORKS session. System settings allow you to control and
customize your work environment. For example, you might like
working with colored viewport background. I don’t. Since this is.a
system setting, parts or assemblies opened on your system woglld have
a colored viewport. The same files opened on my system weuld, not.

Document properties

These settings are applied to the individual document. Fottexample,
units, drafting standards, and material properties (density) are all
document settings. They are saved with the decument and do not
change, regardless of whose system the document 1s"opened on.

Document templates

Document templates are pre-definedddocuments that were set up with
certain specific settings. For example,you might want two different
templates for parts. One with Bnglishisettings such as ANSI drafting
standards and inch units, and onie with ' metric settings such as
millimeters units and IS@ drafting Standards. You can set up as many
different document templates as you need. They can be organized into
different folders fof'easy acéess when opening new documents. You
can create documentit€mplates for parts, assemblies, and drawings.

Object

Many tiggesithe properties of an individual object can be changed or
edited ‘Eorexample, you can change the default display of a dimension
to suppress,one or both extension lines, or you can change the color of a
feature.

The Search option can be used to find information from
SOLIDWORKS Help, Commands, Files and Models on your system
by searching for any part of the name (requires Windows Desktop
Search engine), or MySolidWorks information. Search using this
procedure:

m  Choose which type of search you would | &) 501 10works Help
like to do. Commands
m Type a name or partial name into the 3 |Files and Models
Search box and click the B [ mysolidworks -
search icon /.‘_) ) G] Knowledge Base
. =, [
m For my.solidworks.com searches, : MR Forim
. . N Bl v
click MySolidWorks and one or more o% Slogs
. ) CAD Models
sub options.
@ Training
J:f, Youtube
L4 Twitter

2
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o

Introduction t ching
o

Upon successful cg @ iomf this lesson, you will be able to:

m Create a p

m Insert €

mE A metry.

m_, Establish sketch relations between pieces of geometry.

rstand the state of the sketch.

O xtrude the sketch into a solid.

O&
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2D Sketching This lesson introduces 2D sketching, the basis of modeling in
SOLIDWORKS.

Sketches are used for all sketched features in SO@

including:
m Extrusions m Revol
m  Sweeps

The illustration below shows how a€ tch can form the basis of

several different types of featur:
Extru ;evolve Sweep Loft

ais lessom, only extruded features will be covered. The others will
ered in detail in later lessons or courses.

Stages in the
Process

very sketch has several characteristics that contribute to its shape, size
and orientation.

m New part
New parts can be created in inch, millimeter or other units. Parts are
used to create and hold the solid model.

m Sketches
Sketches are collections of 2D geometry that are used to create solid
features.

m Sketch geometry
Types of 2D geometry such as lines, circles and rectangles that make up
the sketch.

m Sketch relations
Geometric relationships such as horizontal and vertical are applied to
the sketch geometry. The relations restrict the movement of the entities.

28



SOLIDWORKS 2020 - 2021

Procedure

Introducing:
New Part

Where to Find It

Lesson 2
Introduction to Sketching

State of the sketch
Each sketch has a status that determines whether it is ready to be used
or not. The state can be fully-, under- or over defined.

Sketch tools
Tools can be used to modify the sketch geometry that has been created.
This often involves trimming or extending entities.

Extruding the sketch
Extruding uses the 2D sketch to create a 3D solid feature.
The process in this lesson includes sketching and extrusi & n
with, a new part file is created.

The New tool creates a new SOLIDWORKS docgment fronva

selection of part, assembly or drawing templates{There are several
training templates in addition to the default on
m Menu Bar: New [

m Menu: File, New

m Keyboard Shortcut: Ctri+N O
New part.

Click New [ and cli art_ MM template from the Training
Templates tab on w SOLIDWORKS Document dialog box, and
click OK.

Boa

SERATY]  Assembly IN  Assembly . A _Size_AM.. Preview

_AM.. C_Size_AMNS.. C_Size_AN.. Drawing_A... Drawing_I50

%) (o] [

The part is created with the settings of the template including the units.
This part template uses millimeters as the units. You can create and
save any number of different templates, all with different settings.
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Saving Files

Save

Where to Find It

Save As

Save As Copy to
Disk

Save As Copy and
Open

SOLIDWORKS 2020 - 2021

Saving files writes the file information in RAM to a location on a fixed
disk. SOLIDWORKS provides three options for saving files. Each has
a different effect on file references.

Copy the file in RAM to the fixed disk, leaving the copy in RAM open.
If this file is being referenced by any open SOLIDWORKS files, there
are no changes to the reference.

m  Menu Bar: Save &
m Menu: File, Save
m Keyboard Shortcut: Ctrl+S \

Copy the file in RAM to the fixed disk under a ne e o file type,
replacing the file in RAM with the new file. The 61d file,in RAM is
closed without saving. If this file is being referen¢ed by any open

ing referenced by any
pdate the references to this

under a new name or file type,
al open.

=l
- | 4 ‘ ‘ Search Case Study o]
- @
-~
b b
| Case Study E
. Completed Case Study
|| Exercises ‘: Completed Case
3 Study
. Lesson03
. Lesson04
. Lesson05
) LessonD6
. Lesson(7 -
File name: m -
Save as type: [Part (*.prt;*.sldprt) hd
Description: Add a description
@ Save as Include all referenced compenents
() Save as copy and continue Add prefix
Advanced
() Save as copy and open Add suffix
= Hide Folders [ Save ] [ Cancel
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Wh_at are We The first feature of a part will be created in this section. That initial
g |(()I? t?o feature is just the first of many features needed to complete the part.
etcn¢«

Sketching Sketching is the act of creating a 2D profile compti
geometry. Typical geometry types are lines, arcs,/Circles,and ellipses.
Sketching is dynamic, with feedback from th i i

Default Planes To create a sketch, you must choose a plane on which to sketch. The
system provides three initial planes by default. They are Front Plane,
Top Plane, and Right Plane.

Introducing: Sketch When creating a new sketch, the ““ opens the sketcher on the

currently selected plane or plana c. You also use the Sketch tool to
edit an existing sketch.

If you have not preselec r plane before activating the Sketch

tool, the cursor x ears ndicating that you should select a face or
plane.

Where to Find It m Com nager: Sketch > Sketch [
E M rt,"Sketch
m Shortéut Menu: Right-click a plane or planar face and click

ketch

O&
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Note

Open a new sketch.

Click [ . This will show all three
default planes for selection in a
Trimetric orientation. A
Trimetric orientation is a pictorial
view that is oriented so the three
mutually perpendicular planes
appear unequally foreshortened.

From the screen, choose the Front
Plane. The plane will highlight and
rotate.

The Reference Triad (lower left corner) sho ieptation of
the model coordinate axes (red-X, green-¥, and blue-Z) at all .
times. It can help show how the view osientati s been

changed relative to the Front Plane

Sketch active.

The selected Front Plane
rotates so it is parallel to
screen.

indicati

9@
@

Introducing:

Confirmation Corner

Sketch Indica

32

many SOLIDWORKS commands are active, a symbol or a set of
appears in the upper right corner of the graphics area. This
reayis called the Confirmation Corner.

en a sketch is active, or open, the Confirmation Corner
displays two symbols. One looks like a sketch. The other is a
red X. These symbols provide a visual reminder that you are
active in a sketch. Clicking the sketch symbol exits the sketch and saves
any changes. Clicking the red X exits the sketch and discards any
changes.

When other commands are active, the confirmation corner v
displays a check mark and an X. The check mark executes the
current command. The X cancels the command.

Press the D key to move the confirmation corner to the pointer
: - X
location.
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Sketch Entities

Sketch Geometry

Lesson 2
Introduction to Sketching

SOLIDWORKS offers a rich variety of sketch tools for creating profile
geometry. In this lesson, only one of the most basic shapes will be used:
Lines.

The following chart lists some of the sketch entities that are available:

Sketch Entity Button Geometry Example
Line S /
Circle G @
Perimeter Circle ]

Centerpoint Arc b '\
Tangent Arc P!
3 Point Arc ™
Ellipse & ®
Partial Ellipge o Clj
Parabola \J

\‘J‘_'/
Spline \ /,_\_J
Straight Slot )
Centerpoint ®
Straight Slot
3 Point Arc Slot
Centerpoint Arc L
Slot
Polygon @ Q
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Basic Sketching

The Mechanics of
Sketching

34
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Sketch Entity Button Geometry Example

Corner Rectangle I
Center Rectangle = =

. \,< |
(Construction A i
geometry can be
added to any type)
3 Point Corner <>
Rectangle %
3 Point Center &
Rectangle
Parallelogram T :7
Point . *
Centerline P -

The best waytobegin sketching is by using the most fundamental

shape, thé Line.

To sketchg@eometry, there are two techniques that can be used:

o Click-Click

Pesition the cursor where you want the line to start. Click (press
and release) the left mouse button. Move the cursor to where you
want the line to end. A preview of the sketch entity will follow the
cursor like a rubber band. Click the left mouse button a second
time. Additional clicks create a series of connected lines.

m Click-Drag

Position the cursor where you want the line to start. Press and hold
the left mouse button. Drag the cursor to where you want the sketch
entity to end. A preview of the sketch entity will follow the cursor
like a rubber band. Release the left mouse button.
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Introducing:
Insert Line

Where to Find It

Introducing: Sketch
Relations

Lesson 2
Introduction to Sketching

The Line tool creates single line segments in a sketch. Horizontal and
vertical lines can be created while sketching by watching for the
feedback symbols on the cursor.

m CommandManager: Sketch > Line 7

m  Menu: Tools, Sketch Entities, Line

m Shortcut Menu: Right-click in the graphics area and click
Sketch Entities, Line ./~

Sketch Relations are used to force a behavior on a sketc
detail

thereby capturing design intent. They will be discussed i
Sketch Relations on page 41.

Important!

Sketch a line.

Click Line ./~ and sketch a horizontal ling from'he origin. The —
symbol appears at the cursor, indicating thatia Horizontal relation will
be automatically added to the line. er indicates the length of
the line. Click again to end the li

T - 878

Do not b ed with making the line the exact length.
SOLI l V K ftware is dimension driven — the dimensions control
the size of the geometry, not the other way around. Make the sketch
1mat ly the right size and shape and then use dimensions to
xact.

at angle.
artlng at the end of the first line,
ketch a line at an angle.

!

The pencil icon at the cursor will be omitted for clarity.
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Inference Lines

(Automatic
Relations)

Note

SOLIDWORKS 2020 - 2021

In addition to the relation symbols, dashed inference lines will also
appear to help you “line up” with existing geometry. These lines
include existing line vectors, normals, horizontals, verticals, tangents
and centers.

Note that some lines capture actual
geometric relations, while others

simply act as a guide or reference

when sketching. A difference in the .__o.az
color of the inference lines will /=
distinguish them. In the picture at the !

right, the lines labeled “A” are N
yellow, and if the sketch line snaps to I
them, a tangent or perpendicular ]
relationship will be captured.

a reference, in this case
Nline'is ended at this point,

The line labeled “B” is blue. It only proyi
vertical, to the other endpoint. If thegk
no vertical relation will be captured.

36

s 26,678

/‘J.n

ursor symbol indicates that you
e capturing a perpendicular relation.

Perpendicular.
Create another perpendicular line from VAN
the last endpoint, again capturing a /

. . oL 274802, 900
perpendicular relation. /m
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9

10

Note

Sketch Feedback

Lesson 2
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Reference.

Create a horizontal line from the last
endpoint. Blue inferences are strictly for
reference and do not create relations.
They are displayed in blue. This
reference is used to align the endpoint
vertically with the origin.

Close.

Close the sketch with a final line
connected to the starting point of the
first line.

A closed contour is confirmed with
shading.

Click Shaded Sketch ContourS @h\from’the Sketch
CommandManager to toggle the shading on and off.

The sketcher has mafy
feedback features. ‘Ghe
cursor will change,to
show what type®t entity
is beingglreated. Tywill
also indigatc What selections on the existing geometry, such as end,
coincidenten) or midpoint, are available using an orange dot when the
cursor is on it.

. A=6376°R = 16805

/’/

-

Three of the most common feedback symbols are:

Symbol

Description

Endpoint

Yellow concentric circles appear at the Endpoint
when the cursor is over it.

Midpoint

The Midpoint appears as a yellow square. It changes
to orange when the cursor hovers over the line.

Coincident
(On Edge)

The quadrant points of the circle appear with a
concentric circle over the centerpoint.
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Turning Off Tools

Status of a Sketch

Under Defined
[ () Sketch1

Fully Defined

[ sketchl

Over Defined

[ A (+) sketchl

Note

Rules That
Govern
Sketches

SOLIDWORKS 2020 - 2021

Turn off the active tool using one of these techniques:

m Menu Bar: Select [
m  CommandManager: Click the active tool to toggle the tool off
m Keyboard Shortcut: Esc

Turn off the tool.
Press the Esc key on the keyboard to turn off the line tool.

Sketches can be in one of five definition states at anygime. The'status
of a sketch depends on geometric relations betweensgeometny and the
dimensions that define it. The three most common states,are:

The sketch is inadequately defined, but the sketeh €ansstill be used to
create features. This is good because man¥itimes in the early stages of
the design process, there isn’t sufficicntiformation to fully define the
sketch. When more information becomes available, the remaining
definition can be added at a laterfime. Wnder defined sketch geometry
is blue (by default).

The sketch has all the infermationmm€cessary to fully describe the
geometry. Fully definedgeom€try is black (by default). As a general
rule, when a part isgieleasedito manufacturing, the sketches within it
should be fully defined.

The sketch h@s duplicate dimensions or conflicting relations and it
should not'be used until repaired. Extraneous dimensions and relations
shoulddbe deleted."Over defined geometry is red (by default).

The,two other states are No Solution Found and Invalid Solution
Found. They both indicate that there are errors that must be repaired.

Different types of sketches will yield different results. Several different
types are summarized in the table below. It is important to note that
some of the techniques shown in the table below are advanced
techniques that are covered either later in this course, or in other
advanced courses.

Sketch Type

Description Special Considerations

A typical “standard”
sketch that is a neatly
closed contour.

None required.
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Multiple nested None required.
contours creates a boss
with an internal cut.

Open contour creates a | None required.
thin feature with
constant thickness.

Corners are not neatly | Use the Contour Select Toél.
closed. They should be. | Although this sketch will Worky,it
represents poor techniffue and slGppy
work habits. Do ngt dg it.

Sketch contains a self- Select Tool. If both con-

intersecting contour.

though this will work, multibodies are
an advanced modeling technique that you
should not use until you have more

experience.
The s ains This type of sketch can create a Multibody
isjoint céntours. Solid. See Multibody Solids in the

Advanced Part Modeling course.
Although this will work, multibodies are
an advanced modeling technique that you
should not use until you have more
experience.

N .J | 'L-Q

12 Current sketch status.

The sketch is Under Defined
because some of the geometry is
blue. Note that endpoints of a line
can be a different color and
different state than the line itself.
For example, the vertical line at n
the origin is black because it is (a)
vertical, and (b) attached to the
origin. However, the uppermost B
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Tip

Design Intent

What Controls
Design Intent?

Tip

40

13

14
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endpoint is blue because the length of the line is under defined.

Dragging.

Under defined geometry (blue) can be
dragged to new locations. Fully defined
geometry cannot. Drag the uppermost
endpoint to change the shape of the
sketch. The dragged endpoint appears
as a blue dot.

Undo the change.

Undo the last command by clicking the Undo, =¥ optiofl You can see
(and select from) a list of the last few commands, byselicking the down
arrow menu. The keyboard shortcut for Undo is Ctri+Z.

You can also Redo @ a change, whigch reverts it back to the state prior
to undo. The shortcut for redo issCtrl+Ye

The design intent, as disclissed earlier, governs how the part is built and

how it will change. In this,example, the sketch shape must be allowed
to change in these ways:

Design intent in a sketch is captured and controlled by a combination of
two things:

m Sketch relations
Create geometric relationships such as parallel, collinear,
perpendicular, or coincident between sketch elements.

m Dimensions
Dimensions are used to define the size and location of the sketch
geometry. Linear, radial, diameter and angular dimensions can be
added.

To fully define a sketch and capture the desired design intent requires
understanding and applying a combination of relations and dimensions.

The relations are visible because View, Hide/Show, Sketch Relations
is toggled on. If it is turned off, clicking the geometry will show the
relations and open the PropertyManager.
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Desired Design
Intent

Note

Sketch
Relations

Automatic Sketch
Relations

Lesson 2
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The relations will be toggled off at this point, but they will still appear
on selected geometry.

In order for the sketch to change properly, the correct relations and
dimensions are required. The required design intent is listed below:

Horizontal and vertical
lines .
"]

Angle value
Diving
Andle

Parallel Distance value Disfafice

iy

Right-angle corness, or Right Angle
perpendiculaflings l j

Qverall length value

p=— Overall Length

The shading has been removed from table images for clarity.

Sketch Relations are used to force a behavior on a sketch element
thereby capturing design intent. Some are automatic, others can be
added as needed. In this example, we will look at the relations on one
of the lines and examine how they affect the design intent of the sketch.

Automatic relations are added as geometry is sketched. We saw this as
we sketched the outline in the previous steps. Sketch feedback tells you
when automatic relations are being created.
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Added Sketch For those relations that cannot be added automatically, tools exist to
Relations create relations based on selected geometry.

Introducing: Display/Delete Relations shows the relations in a sketch. It also
Display/Delete enables you to remove relations.

Relations

Where to Find It m CommandManager: Sketch > Display/Delete Relations ls

m  Menu: Tools, Relations, Display/Delete
m Properties PropertyManager: Existing Relations

15 Display the relations associated with a line.
Click the uppermost angled line and the
PropertyManager opens. The Existing Relation
box in the PropertyManager lists the geometri
relations that are associated with the selec

Perpendicularl
Perpendicular2

® Under Defined

I symbael is selected, it changes color and
s the entities it controls.

rag the endpoint.

ecause the line is no longer constrained to be i
perpendicular, the sketch will behave
differently when you drag it. Compare this to
how the sketch behaved when you dragged it in
step 13.
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Sketch Relations
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There are many types of Sketch Relations. Which ones are valid
depends on the combination of geometry that you select. Selections can
be the entity itself, endpoints or a combination. Depending on the
selection, a limited set of options is made available. The following
chart shows some examples of sketch relations. This is not a complete
list of all geometric relations. Additional examples will be introduced
throughout this course.

Relation Before After

Coincident between m
a line and an
endpoint.

Parallel between m
two or mere [1nes.

=]

Perpendicular m
between two lines.

Merge between two
endpoints. ﬂ
/
No
/Dﬁ /

a
a

Collinear between
two or more lines. o

43



Lesson 2 SOLIDWORKS 2020 - 2021
Introduction to Sketching

Relation Before After

Horizontal applied
to one or more lines. =

Horizontal between
two or more
endpoints.

Equal between two
or more lines.

Vertical applied to
one or more lines.
m
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Introducing: Add
Relations

Where to Find It

Selecting Multiple
Objects

Lesson 2
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Relation

Before

After

Equal between two
Or more arcs or
circles.

Midpoint between a
line and an endpoint.

Tangent between a
line and an arc/circle
or two arc/circles.

Tangent/bétween a
line anld anfareusing
the commen

éndpoint.

Add Relations is used to create a geometric relationship such as

parallel or collinear between sketch elements.

m CommandManager: Sketch > Display/Delete Relations ls >

Add Relation |

m Menu: Tools, Relations, Add
m Shortcut Menu: Select one or more sketch objects and click a

relation

As you learned in a previous lesson, you select objects with the left
mouse button. What about when you need to select more than one
object at a time? When selecting multiple objects, SOLIDWORKS

follows standard Microsoft® Windows conventions: hold down the Ctrl

key while selecting the objects.
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18 Add a relation.
Hold down Ctrl and click the two lines. The con- ]
text menu shows only those relations that are
valid for the geometry selected.

Click Make Perpendicular.

— I SLN = &
el R i Sl
19 Drag the sketch.

Drag the sketch back into approximately
its original shape.

Dimensions Dimensions are another geometry and capture design
intent in the SOLIDW m. The advantage of using a
dimension is that it4 both display the current value and change
it.

Introducing: The Smart iomtool determines the proper type of dimension
Smart Dimensions based on chosen, previewing the dimension before
ple, if you pick an arc the system will create a

sion, While selecting two parallel lines will create a linear
ion between them. In cases where the Smart Dimension tool

oving the dimension to different measurement positions.

Where to Find It m CommandManager: Sketch > Smart Dimension &*
m  Menu: Tools, Dimensions, Smart
m  Shortcut Menu: Right-click in the graphics area and click

Smart Dimension £
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Dimensioning:
Selection and
Preview

Note

Lesson 2
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As you select sketch geometry with the dimension tool, the system
creates a preview of the dimension. The preview enables you to see all
the possible options by simply moving the mouse after making the
selections. Clicking the left mouse button places the dimension in its

current position and orientation. Clicking the right mouse button h@
locks only the orientation, allowing you to move the text before fin
placement by clicking the left mouse button.

With the dimension tool and two endpoints selected, below ar

possible orientations for a linear dimension. The value is '
the initial point to point distance and may change bas

orientation selected. C)

Endpoints

|-—23.281 —=]

ption is to select the geometry that is to be dimensioned and
Auto Insert Dimension .

Adding a linear dimension.
Click Smart Dimension € and

click the line shown and right-click 0

h@ to lock in the orientation. Click o /\
again to place the text as shown. The v x @ 2 %
dimension appears with a Modify D1@sketent

tool displaying the current length of 20.000mr| >

the line. The thumbwheel is used to
incrementally increase/decrease the /
value using the middle mouse '

button. Or with the text highlighted, you can type a new value to
change it directly.
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Note A midpoint location can be inadvertently selected
instead of the geometry itself. To avoid this, select the /\ <
geometry slightly off center. *"?

The Modify Tool The modify tool that appears when you create or
edit a dimension (parameter) has several
options. The options available to you are:

%s Change the th

& Mark the ension for drawing import.

Note The di n can be changed in the upper section of the dialog
box.

Units in the Modify different from the part units can be

Madify

Tool ected for the input. When typing the v x @ At
value, select the Units > menu and select p1¢ Distance |
put units. 20 :

Unit abbreviations and fractions can also be typed into the value field
after the numeric value (for instance 0.375in or 3/8”).
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21 Set the value.
Change the value to 20 and click the

Save v option. The dimension
forces the length of the line to be
20mm.

v

Tip Pressing Enter has the same effect as clicking the¢ Sav

22 Linear dimensions.
Add additional linear dimensions
to the sketch as shown.

Dimensioning Tip When you dimension a sketch, /\
start with the smallest dimensi
first, and work your way to th
largest.

T et 39—
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Angular Angular dimensions can be created using the same dimension tool used

Dimensions to create linear, diameter and radial dimensions. Select either two lines
that are both non-collinear and non-parallel, or select three non-
collinear endpoints.

Depending on where you place the angular dimension, you can get the
interior or exterior angle, the acute angle, or the oblique angle. Possi

placement options:

121.427 5& 580

t

u}

5.5 58.58°
.

ular dimension.
sing the dimension tool, create y
e angular dimension shown and 20

set the value to 125°. l /Q\

The sketch is fully defined. See

Fully Defined on page 38. 25 125.00°

T [ 3D ——— -
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Instant 2D

Note

Where to Find It

Lesson 2
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Instant 2D can be used to manipulate sketch dimensions, dynamically
changing the values using a graphic Ruler.

The ruler is displayed to guide the drag. Moving closer to the ruler
gradients allows you to snap to them.

m CommandManager: Sketch > Instant 2D [@

24

Select dimension. 0
The Instant 2D tool is on by default. Select the 125° dimdension.

Click and hold the round ball handle at the tip of the arro

The value of the dimension, and the geometry, changes namically as

the handle is dragged.
Drag the value to 135° using the ruler.

20
DN
13500° Al 18°

: .

Qg

188

N
T [ 3D ——— -

Extrude Qn ¢ the sketch is completed, it can be extruded to create the first

Fmd .t

ature. There are many options for extruding a sketch including the
start and end conditions, draft and depth of extrusion, which will be
discussed in more detail in later lessons. Typically, extrusions take
place in a direction normal to the sketch plane, in this case the Front
plane.

m CommandManager: Features > Extruded Boss/Base ]
m Menu: Insert, Boss/Base, Extrude
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25 Extrude.
Click Extruded

Boss/Base .

On the Features
CommandManager tab, the
options for other methods of
creating features are listed along
with Extrude and Revolve. They
are unavailable because this
sketch does not meet the
conditions necessary for creating
these types of features. For
example a Sweep feature

requires both profile and path sketches. S
at this time, the Sweep option is unavailab

The view automatically changes to
feature is shown at the default

I’
"

e the

is only one sketch

c and a preview of the

Drag Handles and
Rulers

O

52

Handles o appear that
used to drag the

desired depth. eis
colored whlle in the
active dlrect callout shows
the curr eand a
ruler.

O
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26 Extrude Feature settings. @] Boss-Extrude @
Change the settings as shown. v x ®

m End Condition = Blind From "
| @ (Depth) = 6mm [Ske'(ch Plane

Click OK v to create the feature.
A
Tip The OK button + is just one way to accept and I
complete the process. A second is to press the & e
Enter key.
A third method is the set of OK/Cancel buttons injthe v
Confirmation Corner of the graphics area, or D key

to bring it to the cursor.

A fourth method is to right-clic c K B Selection
from the shortcut menu. S Lasso Selection
E@ Select Other
Clear Selections
Zoom/Pan/Rotate »
v 0K
¥ Cancel
27 Comple r

ture is the first solid,
or feature'@f the part. The sketch is
the Extrudel feature.

Note Click the » preceding the feature name to expand @) Boss-Extrudel
the feature and show the sketch.
- ﬁ Boss-Extrudel

[ Sketchl
28 Save and close.
Click Save [ then click File, Close to close the part.
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Sketching
Guidelines

54
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Following is a collection of “rules of thumb” or best practices for
sketching of which all SOLIDWORKS users should be aware. Some of
these tips are covered in substantial detail in subsequent lessons within
this book.

Keep your sketches simple. Simple sketches are easier to edit, less
likely to develop errors, and help with downstream features suchias
configurations.

Make use of the origin in your first sketch.

The first sketch of a new part should represent the ma@in prefile of
the part.

Create sketch geometry first, add geometric r€lationghips second,
and then add your dimensions last. Dimensions can Sometimes
interfere with the addition of required relations.

Use geometric relations wherever possible tognaintain design
intent.

Draw the sketch to approximatelyy thesight scale to prevent errors
or geometry overlap when §ou start adding dimensions.

Add or edit dimensiofis on'the closest / smallest geometry first, then
work your way toithe‘etiter / larger geometry to prevent geometry
overlap.

Use relations, equations, and global variables to reduce the number
of independent dimensions needed.

Take advantage of symmetry. Use the Mirror or Dynamic Mirror
sketch tool to mirror sketch elements and add symmetrical
relations.

Be flexible. It may be necessary to change the order in which
you’re adding dimensions or relations. Drag the sketch geometry
closer to the required location before adding dimensions.

Fix errors as they occur. Use SketchXpert and Check Sketch for
Feature which can quickly help you identify problems and correct
them.

T Thanks to Joe Medeiros, Javelin Technologies.
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Exercise 1: Create this part using the information and
Sketch and dimensions provided. Sketch and extrude
Extrude 1 profiles to create this part.

This lab reinforces the following skills:

m [ntroducing: New Part on page 29

m  Sketching on page 31

m Inference Lines (Automatic
Relations) on page 36

m  Dimensions on page 46

m  Extrude on page 51

A

Units: millimeters
1 New part.
Create a new part using the Part_ MM template:

2 Sketch.
Create this sketch on the Front Plaf

and dimensions.
—ay O
[ (</! S

g lines, automatic relations

100 !

xtrude.
xtrude the sketch 50mm in
depth.

O&

4 Save and close the part.
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Exercise 2
Sketch and Extrude 2

Exercise 2:
Sketch and
Extrude 2

4 Save and close the part.

SOLIDWORKS 2020 - 2021

Create this part using the information and
dimensions provided. Sketch and extrude
profiles to create this part.

This lab reinforces the following skills:

m [ntroducing: New Part on page 29

m  Sketching on page 31

m Inference Lines (Automatic
Relations) on page 36

m  Dimensions on page 46

m  Extrude on page 51

Units: millimeters

New part. Q
Create a new part using the Part_MM ten@

Sketch.
Create this sketch on the Front Plaf

and dimensions.
_i—' O

g lines, automatic relations

70 —‘

rude the sketch 50mm in

56



SOLIDWORKS 2020 - 2021 Exercise 3
Sketch and Extrude 3

Exercise 3: Create this part using the information
Sketch and and dimensions provided. Sketch and
Extrude 3 extrude profiles to create this part.

This lab reinforces the following skills:

m [ntroducing: New Part on page 29

m  Sketching on page 31

m Inference Lines (Automatic
Relations) on page 36

m  Dimensions on page 46

m  Extrude on page 51

Units: millimeters
1 New part.

Create a new part using the Part_ MM template.

2 Sketch.
Create this sketch on the Front Pls @ lines, automatic relations

and dimensions.
) O
45 @

rude.
xtrude the sketch 25mm in depth.

1

8

ol |

O&

4 Save and close the part.
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Sketch and Extrude 4

Exercise 4: Create this part using the information
Sketch and and dimensions provided. Sketch and
Extrude 4 extrude profiles to create this part.

This lab reinforces the following skills:

m [ntroducing: New Part on page 29

m  Sketching on page 31

m Inference Lines (Automatic
Relations) on page 36

m  Dimensions on page 46

m Extrude on page 51

Units: millimeters

1 New part.
Create a new part using the Part_ MM template.

2 Sketch.
Create this sketch on the
Front Plane using lines,
automatic relations and
dimensions.

75

—15

rude.
xttude the sketch 100mm in depth.

O

4 Save and close the part.
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Exercise 5:
Sketch and
Extrude 5

O

Exercise 5
Sketch and Extrude 5

Create this part using the information and
dimensions provided. Sketch and extrude
profiles to create the part.

This lab reinforces the following skills:

m [ntroducing: New Part on page 29

m  Sketching on page 31

m Inference Lines (Automatic Relations) on
page 36

m  Dimensions on page 46 \
m Extrude on page 51 &

Units: millimeters
New part.
Create a new part using the Part_ MM template:

Sketch.
Create this sketch on the Front Plaxe ‘
and dimensions.

Fully define the sketch. O

60

lines, automatic relations

4 Save and close the part.

59



Exercise 6 SOLIDWORKS 2020 - 2021
Sketch and Extrude 6

Exercise 6: Create this part using the information and
Sketch and dimensions provided. Sketch and extrude
Extrude 6 profiles to create the part.

This lab reinforces the following skills:

m [ntroducing: New Part on page 29

m  Sketching on page 31

m [nference Lines (Automatic Relations)
on page 36

m  Dimensions on page 46

m Extrude on page 51 &\
Units: millimeters

1 New part.
Create a new part using the Part_ MM template:

2 Automatic relations.
Create this sketch on the Front Pla
relations. Show the Perpendic

lines and automatic
itical relations.

3 Dimensig

Add di @

sketch.

O 4

4 Extrude.
Extrude the sketch 12mm.

fully define the 75° /g

5 Save and close the part.
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OQ

reate Hole Wizard holes.

fillets on a solid.

se the editing tools Edit Sketch, Edit Feature and Rollback.
O Make a basic drawing of a part.
m Make a change to a dimension.

m Demonstrate the associativity between the model and its drawings.
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Basic Modeling  This lesson discusses the
considerations that you
make before creating a
part, and shows the
process of creating a

simple one.
Stages in the The steps in planning and executing the creation ©f this part are listed
Process below.
m Terminology
What are the terms commonly used w ingzabout modeling and

using the SOLIDWORKS software

m Profile choice
Which profile is the best one t @ when starting the modeling
process?

m Sketch plane choice

Once you’ve chos b rofile, how does this affect your choice
of sketch plane?,
m Design inte
What is designintent and how does it affect the modeling process?
m Newp
Opening the new part is the first step.
] ature
at 1s the first feature?
osses, cuts and hole features
ow do you modify the first feature by adding bosses, cuts and holes?
m Fillets

Rounding off the sharp corners — filleting.

m Editing tools
Use three of the most common editing tools.

m Drawings
Creating a drawing sheet and drawing views of the model.

m Dimension changes
Making a change to a dimension changes the model’s geometry. How
does this happen?

62



SOLIDWORKS 2020 - 2021

Terminology

Feature

Plane

Extrusion

Sketch

Boss

Cut

Fillets and Rounds

Design Intent

Lesson 3
Basic Part Modeling

Moving to 3D requires some new terminology. The SOLIDWORKS
software employs many terms that you will become familiar with
through using the product. Many are terms that you will recognize from
design and manufacturing such as cuts and bosses.

All cuts, bosses, planes and sketches that you create are considered
Features. Sketched features are those based on sketches (boss and clit)y
and applied features are applied directly to existing geometry (fillet),

Planes are flat and infinite. They are represented on the screen with
visible edges. They are used as the primary sketch surface fogcreatifig
boss and cut features.

Although there are many ways to e

create features and shape the solid, ~

for this lesson, only extrusions

will be discussed. An extrusion

will extend a profile along a path \
typically normal to the profile

plane for some distance. The

movement along that path bec@mes the solid model.

In the SOLIDWORKS system, thesname used to
describe a 2D profile is ske#eh-"Sketches are created
on flat faces and plahes within the model. They are
generally used as the basis for bosses and cuts,
although theyfcan existindependently.

R10

Bosses atgfused to add material to the model. The critical initial feature
issabways a'boss. After the first feature, you may add as many bosses as
needed to complete the design. As with the base, all bosses begin with a
sketch.

A Cut is used to remove material from the model. This is the opposite
of the boss. Like the boss, cuts begin as 2D sketches and remove
material by extrusion, revolution, or other methods you will learn
about.

Fillets and rounds are generally added to the solid, not the sketch. By
nature of the faces adjacent to the selected edge, the system knows
whether to create a round (removing material) or a fillet (adding
material).

How the model should be created and changed, is considered the design
intent. Relationships between features and the sequence of their
creation all contribute to design intent.
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Choosing the Choose the “best” profile for the model's base feature. This profile,
Best Profile when extruded, will generate more of the model than any other. Look at
these models as examples.

Part Best Profile Extruded
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Choosing the
Sketch Plane

Planes

Placement of the
Model

Orient the\Model for
the Drawing

Lesson 3
Basic Part Modeling

Once the best profile is determined, the next step is to decide which
view to use and select the plane with the same name for sketching it.
The SOLIDWORKS software provides three planes; they are described
below.

There are three default planes, labeled Front Plane, Top Plane and
Right Plane. Each plane is infinite, but has screen borders for viewifig
and selection. Also, each plane passes through the origin and is
mutually perpendicular to the others.

The planes can be renamed. In this course the names Fromt PlanesPop
Plane and Right Plane are used. This naming convention is used in
other CAD systems and is comfortable to many useis,

Although the planes

are infinite, it may be

easier to think of them

as forming an open

box, connecting at the

origin. Using this

analogy, the inner

faces of the box are the <

potential sketch K
planes.

The part willbe placedyinto the box three times. Each time the best
profile will contact opbe parallel to one of the three planes. Although
there arg'many comibinations, the choices are limited to three for this
exercisel

When choosing the sketch plane, consider the part's appearance and its
orightation in an assembly. The appearance dictates how the part will
beyoriented in standard views such as the Isometric. It also determines
how you will spend most of your time looking at the model as you
Create it.

The part's orientation in an assembly dictates how it is to be positioned
with respect to other, mating parts.

Another consideration when deciding which sketch plane to use is how
you want the model to appear on the drawing when you detail it. You
should build the model so that the front of the model is the same as the
Front view in the drawing. This saves time during the detailing process
because you can use predefined views.
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In the first example, the best
profile is in contact with the Top
plane.

In the second example, it is
contacting the Front plane.

The last example shows the best
profile in contact withithe Right
plane.

Chosen Plane The Tap plane orientation seems
to be thebest. This indicates that
thebest profile should be

sketched on the Top plane of the

meodel.

SOLIDWORKS 2020 - 2021

Right Plane Front Plane
Top Plane
Right Plane Front Plane

Top Plane

Right Plane Front Plane

/

Top Plane

How it lkooks onthe By giving careful thought to

Drawing which plane is used to
sketch the profile, the
proper views are easily
generated on the detail

drawing.
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Details of the
Part

Standard Views

Main Bosses

O

Bes ile

O

Lesson 3
Basic Part Modeling

The part we will be creating is shown below. There are two main boss
features, some cuts, and fillets.

The part is shown here in four standard views. < ’

(i i)

The two main bosse i

profiles in differe .

are connected a8 shown in the
1g

exploded vi

Q.

The first feature of the model
is created from the
rectangular sketch shown
overlaid on the model. This is
the best profile to begin the
model.

The rectangle will then be
extruded as a boss to create
the solid feature.
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Sketch Plane

Design Intent

SOLIDWORKS 2020 - 2021

Placing the model “in the box™ determines which plane should be used
to sketch on. In this case it will be the Top plane.

Sketch Plane Q
The design intent of this part describe A ’s relationships

should or should not be created. As €hanges to the model are made, the
model will behave as intended.

m All holes are through hole

m The slot is aligned wi

tab.
m The counterbo

ed hole in"the @
front shar € same center ,

point as d face of
the t
Procedure T ode process includes sketching and creating bosses, cuts and

O

. To begin with, a new part file is created.

part.

lick New [, or click File, New. Create a new part using the
art_MM template and Save it as Basic.

Select the sketch plane.
Insert a new sketch and choose
the Top Plane.

A plane doesn’t have to be shown
in order to be used; it can be
selected from the
FeatureManager design tree.
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Sketching the First
Feature

Introducing:
Corner Rectangle

Where to Find It

Lesson 3
Basic Part Modeling

Create the first feature by extruding a sketch into a boss. The first
feature is always a boss, and it is the first solid feature created in any
part. Begin with the sketch geometry, a rectangle.

Corner Rectangle is used to create a rectangle in a sketch. The
rectangle is comprised of four lines (two horizontal and two vertical)
connected at the corners. It is sketched by indicating the locations of
two diagonal corners. There are several other rectangle/parallelogram
tools available:

m Center Rectangle [= - Uses a center point and corner to,createsa
rectangle with horizontal and vertical lines.

m 3 Point Center Rectangle <& - Creates a rectangle based on a
center point, midpoint of edge and corner. Lifies aregperpendicular
at corners.

m 3 Point Corner Rectangle <}» - Uses‘hree corners to define a
rectangle. Lines are perpendiculag@t€ornesss

m Parallelogram /7 - Uses three corners fo define a parallelogram
(corners are not perpendicudar).

m CommandManager: Sketch,> Corner Rectangle [T

m  Menu: Tools, Sketch Entities, Corner Rectangle

m Shortcut Menu: Rightselick in the graphics area and click
Sketch Entitie§, CornenRectangle [ 1

Sketch a rectangle. X = 56.568, y = 33.680
Click Corner Reetangle [ 1

and begigthe rectangle at the
origin.

Make sure the rectangle is locked to the origin by looking for l

the coincident icon next to the cursor as you begin sketching. =

Do not worry about the size of the rectangle. Dimensioning it %

will take care of that in the next step.

Fully defined sketch. 1

Add dimensions to the sketch. The 40

sketch is fully defined. *
125
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Extrude Options

SOLIDWORKS 2020 - 2021

An explanation of some of the more frequently used Extrude options is
given below (see Extrude on page 51). Other options will be discussed
in later lessons.

End Condition Type

A sketch can be extruded in one or two directions. Either or both
directions can terminate at some blind depth, up to some geometry i
the model, or extend through the whole model.

Depth @
The distance for a blind or mid-plane extrusion. For mid-plane, e
to the total depth of the extrusion. That would mean that'a depth o
50mm for a mid-plane extrusion would result in 25mm omeach side of
the sketch plane.

Draft
Applies draft to the extrusion. Draft on the ext
(the profile gets smaller as it extrudes) or

i0 n be inwards

Renaming
Features

6

Extrude.
Click Extrude @] and extrude @ angle 10mm upwards. Click OK.

re that appears in the FeatureManager design tree (aside from
art itself) can be renamed using the procedure below. Renaming
atures is a useful technique for finding and editing features in later
ages of the model. Well chosen, logical names help you to organize

your work and make it easier when someone else has to edit or modify
your model.

Rename the feature.

It is good practice to rename important features that you create with
some meaningful name. In the FeatureManager design tree, use a very
slow double-click to edit the feature Boss-Extrudel. When the name
is highlighted and editable, type BasePlate as the new feature name.
All features in the SOLIDWORKS system can be edited in the same
way.

Instead of using a slow double-click to edit the name, you can select the
name and press F2.
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Boss Feature

Sketching on a
Planar Face

Lesson 3
Basic Part Modeling

The next feature will be the boss
with a curved top. The sketch
plane for this feature will be a
planar face of the model instead
of an existing plane. The required
sketch geometry is shown
overlaid on the finished model.

Any planar (flat) face of the model can be used as a pla

Simply select the face and click Sketch {—_. Wh ces aredifficult
to select because they are obscured by other fac%lect Other
tool can be used to choose a face without reorient view. In this
case, the planar face on the front of the BaisePlate is used.

7

Note

Sketching

Introducing:
Tang rc

@ o Find It

Insert new sketch.
Select the indicated face and cli

Sketch .

Sketch Plane

atlires > Instant 3D 0 is turned off. Leaving it on
andles and axes that we are not currently using to

LIDWORKS offers a rich variety of sketch tools for creating profile
ometry. In this example, Tangent Arc is used to create an arc that
egins tangent to a selected endpoint on the sketch. Its other endpoint

can be placed in space or on another sketch entity.

Tangent Arc is used to create tangent arcs in a sketch. The arc must be
tangent to some other entity, line or arc, at its start.

m CommandManager: Sketch > Arc =" > Tangent Arc )

m  Menu: Tools, Sketch Entities, Tangent Arc

m  Shortcut Menu: Right-click in the graphics area and click
Sketch Entities, Tangent Arc )
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Tangent Arc Intent  When you sketch a tangent arc, the
Zones SOLIDWORKS software infers from the motion

of the cursor whether you want a tangent or / \
normal arc. There are four intent zones, with A

eight possible results as shown.

You can start sketching a tangent arc from the end point of any existi
sketch entity (line, arc, spline, and so on). Move the cursor aw.
the end point.

m  Moving the cursor in a tangent direction creates one
tangent arc possibilities.

m  Moving the cursor in a normal direction creat four
normal arc possibilities.

m A preview shows what type of arc you are s

®  You can change from one type of
returning the cursor to the endp <

direction.

a tangent arc, and back withett clicking Tangent Arc ). You
can do this by returni to the endpoint and moving away in
a different directio sing the A key on the keyboard.

¢ the other by
d'n 0V1ng away in a different

Autotransitioning ~ When using Line ,/*, you can
Between Lines and
Arcs

om sketchmg a line to sketching

art the vertical
ge capturing a
@ relation at the lower

Autotransition.
Move the cursor back to the endpoint and move away in a different
direction.You are now in tangent arc mode.

10 Tangent arc.
Sketch a 180° arc tangent to the
vertical line. Look for the inference
line indicating that the end point of
the arc is aligned horizontally with
the arc’s center.

A= 180° R = 22,706
A

When you finish sketching, the
sketch tool automatically switches
back to the line tool.
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11 Finishing lines.
Create a vertical line from the arc end
to the base, and one more line
connecting the bottom ends of the
two vertical lines.

Note that the horizontal line is black,
but its endpoints are not.

12 Add dimensions.
Add linear and radial
dimensions to the sketch.

As you add the dimensions, 3
move the cursor around to view
different possible orientations.

Always dimension argby selecting on its circumference, rather
than center. Thi other dimensioning options (min and max)

available.

13 Extrude .
Click and set the
Depth to 40mm. Note that the

iew shows the extrusion
the base, in the
er direction.

the direction of the preview is
away from the base, click

Reverse Direction 7

When using the Spin Increment arrows, the

wizdly
default up and down increment is 10mm. v x 8 72 [
Pressing the Alt key with an arrow drops it to D1@sketent

20,000mm|

1/10X, or Imm. Using it with Ctrl key it
increases it 10X to 100mm.
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14 Completed boss.
The boss merges with the previous
base to form a single solid.

Rename the feature VertBoss.

Cut Feature Once the two main boss features are completed, it is t
to represent the removal of material. Cut features

createdvin the
same way as bosses - in this case with a sketch a 1

extrusion.

Introducing: The menu for creating a cut feature by extrudingls 1dentical to that of
Cut Extrude creating a boss. The only difference is the t removes material while
a boss adds it. Other than that disting mands are the same.
This cut represents a slot.

Where to Find It m CommandManager: Featu truded Cut

m  Menu: Insert, Cut,

15 Rectangle.

off the rectangle tool.

ensions.
dd a dimension as shown.

: . |
I -

@ The sketch is under defined, but it will be made fully defined later in
this lesson. See Status of a Sketch on page 38.
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View Selector

Where to Find It

Note

Lesson 3
Basic Part Modeling

The View Selector helps to visualize how
views of the model will appear by using a
transparent cube surrounding the model.

Select a face of the cube to look at the model
through the cube, normal to that face or select
a view orientation by name.

The cube can also be rotated prior to selecting
a face.

m Heads-up View Toolbar: View Orientation (& av«\

View Selector [
m Keyboard Shortcut: Space bar

e Orientation
¢ View Selector.

Pressing the Space Bar opens the View Selec
dialog box. Pressing Ctrl+Space bar ope

17

View Selector.
Press Space Bar and click the
Isometric.

&
A
%

N

cube that is labeled

G

i

3
3
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18 Through All Cut. ot Extrude @
Click Extruded Cut [@. Choose Through All |+ x =
and click OK. This type of end condition always| ... ~
cuts through the entire model no matter how far.| [sketcn piane -
No depth setting was needed. Rename the Drection 1
feature BottomsSlot. [Through A1
b

Using the Hole
Wizard

create a standard hole.

Creating a You can choose the
Standard Hole dimensions and loga
intuitive aspec ;
hole by the fastenér th

Tip You ca p oles on planes and non-planar faces. For example,
you ca ole on a cylindrical face.

goes into it.

nterbare hole is required in this model. Using the front face of the
d a relation, the hole can be positioned.

Counterbore Hole

Note e Advanced Hole Wizard (Insert, Features, Near Side <
dvanced Hole) is similar to the Hole Wizard, but

counterbores, countersinks, tapered, tapped, and L-I iy
standard holes.

Introducing: The Hole Wizard creates shaped holes, such as countersunk and
T e ard counterbore types. The process creates two sketches. One defines the
shape of the hole. The other, a point, locates the center.

ere to Find It m CommandManager: Features > Hole Wizard (&
m Menu: Insert, Features, Hole Wizard
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